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THESIS ABSTRACT
VISUALIZATION OF CHLORELLA ALGAL CELLS AT
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Stephen Alexander Tuin
Master of Science, May 10, 2008
(B.S., Chemical Engineering, 2006)
135 Typed Pages
Directed by Steve R. Duke
This thesis examines flotation as a method for harvesting the green algae chlorella
for its use as a feedstock for biofuel. Lipids extracted from algae can be converted to
biodiesel for use as an alternative renewable energy source. Visualization and image
processing techniques were utilized to study algae flocculation and flotation both
qualitatively and quantitatively. It is hypothesized that imaging techniques may be used
to gain insight into the process of algal flotation.
Flocculation of algae with iron nitrate, alum, chitosan, gelatin, and cellulose was
explored.

Samples of flocculated algae were imaged with light microscopy and

processed to determine the average equivalent floc diameter. Iron nitrate and chitosan
chemistries produce larger flocs than alum and gelatin chemistries. Algae flocculated
with 50 ppm iron nitrate and a 10:1 cellulose to algae mass ratio was found to produce

v

the largest flocs of 190 µm diameter. The smallest average equivalent diameter of 24 µm
was observed for alum and gelatin concentrations of 100 ppm and 6.25 ppm respectively.
Increasing the concentration of the secondary flocculant decreased the average equivalent
diameter. For iron nitrate and chitosan chemistries, the addition of cellulose can replace
the need for chitosan.
Algal cell and bubble interactions were imaged in three bubble facilities: The
stationary bubble facility which suspends a bubble on the tip of a needle in a quiescent
fluid, the suspended bubble facility which suspends a bubble in a down flow of fluid, and
the electrochemical flotation cell which generates very small diameter bubbles.
No algal adsorption to bubbles was observed in the stationary bubble facility.
This was attributed to the large diameter of the bubbles produced in this facility
(approximately 1 mm). Images were useful to visualize the approach of individual algae
cells and larger algae flocs to bubble surfaces. Algae adsorption to bubbles was observed
in the suspended bubble facility during filling of the facility but adsorption was not
observed during normal operation. Algae adsorption to bubble surfaces was successfully
imaged in the electrochemical flotation cell.
Flotation runs were conducted in an electrochemical flotation cell and a Denver
D-12 flotation cell. Algae foam collected in these facilities was processed into algae pads
via vacuum filtration and the mass of algae floated was determined.

The flotation

efficiencies for various flocculation chemistries was evaluated. Iron nitrate and chitosan
concentrations of 50 ppm and 1.25 ppm respectively produced the highest flotation
efficiency of 83%. Flotation efficiency increased with increasing average equivalent
diameter.
vi

ACKNOWLEDGMENTS
The author would like to thank Dr. Steve Duke for support during this research.
His help, motivation, and understanding were essential to the success of this research.
The author would like to thank Dr. Ron Putt for his assistance and insight into algal
culture.
The author would also like to thank all of the undergraduate, graduate, and
exchange students that developed the methods and equipment used in this research. A
special thanks to Lily Raines for her assistance with high-magnification visualization.
Finally, the author would like to thank his parents, Van and Trish, his brother,
Andrew, and his sister, Heather for their support through this research. The author would
especially like to thank Jill Blecha, whom without her love and support this research
could not have succeeded.

vii

Style Manual: TAPPI JOURNAL, ACS
Computer Software Used: Microsoft Word, Microsoft Excel, Corel PhotoPaint 11,
ImageJ, VideoMach

viii

TABLE OF CONTENTS
LIST OF TABLES .........................................................................................................xi
LIST OF FIGURES.......................................................................................................xii
CHAPTER 1: INTRODUCTION ................................................................................... 1
CHAPTER 2: BACKGROUND ..................................................................................... 4
2.1

Algae as a Feedstock for Biofuel .............................................................. 5

2.2

Chlorella as a feedstock for Biofuel ......................................................... 7

2.3

Induced and Dissolved Air Flotation ...................................................... 10

2.4

Flocculation of Algae ............................................................................. 14

CHAPTER 3: EQUIPMENT AND EXPERIMENTAL PROCEDURES ...................... 17
3.1

Algal Culture.......................................................................................... 18

3.2

Chemicals .............................................................................................. 24

3.3

Stir Plate Calibration .............................................................................. 25

3.4

Flocculation Beaker Tests ...................................................................... 28

3.5

Microscope Slide Photographs ............................................................... 34

3.6

Stationary Bubble Facility...................................................................... 41

3.7

Suspended Bubble Facility ..................................................................... 47

3.8

Electrochemical Flotation Cell ............................................................... 51

3.9

Denver D-12 Flotation Cell .................................................................... 57

3.10

Algae Pads ............................................................................................. 61
ix

3.11

Imaging System...................................................................................... 64

CHAPTER 4: RESULTS.............................................................................................. 65
4.1

Flocculation Beaker Tests and Microscope Slide Results........................ 66

4.2

Stationary Bubble Facility Results.......................................................... 74

4.3

Suspended Bubble Facility Results......................................................... 77

4.4

Electrochemical Flotation Cell Results ................................................... 84

4.5

Denver D-12 Flotation Cell Results........................................................ 92

CHAPTER 5: DISCUSSION OF RESULTS ................................................................ 95
5.1

Discussion of Algal Flocculation Results................................................ 96

5.2

Discussion of Algal Cell Adsorption to Bubbles................................... 101

5.3

Discussion of Bubble Imaging Results ................................................. 107

5.4

Recommendations ................................................................................ 108

CHAPTER 6: CONCLUSIONS ................................................................................. 109
BIBLIOGRAPHY ....................................................................................................... 112
APPENDIX A: BLOB ANALYSIS PROCEDURE.................................................... 115
APPENDIX B: MOVIE BUILDING PROCEDURE .................................................. 117
APPENDIX C: LIST OF VIDEOS ............................................................................. 119
APPENDIX D: FLOC SIZE ANALYSIS ................................................................... 121

x

LIST OF TABLES
Table 3-1:

Flocculation beaker test run chemistries ................................................. 31

Table 3-2:

Chemistries tested in the bubble facilities ............................................... 46

Table 4-1:

Chemistries for Figure 4-1 and Figure 4-2 .............................................. 67

Table 4-2:

Chemistries for Figure 4-3...................................................................... 69

Table 4-3:

Chemistries for Figure 4-4...................................................................... 70

Table 4-4:

Chemistries for Figure 4-5...................................................................... 71

Table 4-5:

Chemistries for Figure 4-6...................................................................... 72

Table 4-6:

Chemistries for Figure 4-7...................................................................... 73

Table 4-7:

Chemistries for Figure 4-9...................................................................... 76

Table 4-8:

Chemistries for Figure 4-12.................................................................... 81

Table 4-9:

Chemistries for Figure 4-14.................................................................... 83

Table 4-10:

Chemistries for Figures 4-16 through 4-19 ............................................. 87

Table 4-11:

Flotation efficiency calculations for the EFC.......................................... 90

Table 4-12:

Chemistries for Figure 4-20 and Figure 4-21 .......................................... 93

Table 5-1:

Chemistries for Figure 5-3.................................................................... 106

Table C-1:

List of Videos....................................................................................... 119

Table D-1:

Flocculation beaker test calculations..................................................... 121

xi

LIST OF FIGURES
Figure 2-1:

TEM micrograph of an individual chlorella vulgaris cell.......................... 9

Figure 2-2:

Voith Sulzer Eco flotation cell................................................................ 12

Figure 2-3:

Dissolved air flotation cell...................................................................... 13

Figure 2-4:

Structure of chitin and chitosan .............................................................. 16

Figure 3-1:

Outdoor algal growth pond..................................................................... 21

Figure 3-2:

Relationship between algal concentration and
transmittance at 550 nm.......................................................................... 22

Figure 3-3:

Indoor algal growth tanks ....................................................................... 23

Figure 3-4:

Fisher stir plate 210T calibration curve................................................... 27

Figure 3-5:

Typical flocculation beaker test 1 minute after
addition of the secondary flocculant ....................................................... 32

Figure 3-6:

Typical flocculation beaker test after 15 minutes of settling.................... 33

Figure 3-7:

Low magnification (10x) microscope image
of a typical floc ...................................................................................... 37

Figure 3-8:

High magnification (40x) microscope image
of a typical floc ...................................................................................... 38

Figure 3-9:

Low magnification (10x) microscope image
of a typical floc with cellulose................................................................ 39

xii

Figure 3-10:

High magnification (100x) microscope image
of fresh algae and cellulose..................................................................... 40

Figure 3-11:

Schematic of the stationary bubble facility ............................................. 43

Figure 3-12:

Stationary bubble facility........................................................................ 44

Figure 3-13:

Typical frame from the stationary bubble facility ................................... 45

Figure 3-14:

Schematic of the suspended bubble facility............................................. 49

Figure 3-15:

Suspended bubble facility....................................................................... 50

Figure 3-16:

Schematic of the electrochemical flotation cell ....................................... 54

Figure 3-17:

Electrochemical flotation cell ................................................................. 55

Figure 3-18:

Algae foam generated in the electrochemical flotation cell ..................... 56

Figure 3-19:

Schematic of the Denver D-12 flotation cell ........................................... 59

Figure 3-20:

Denver D-12 flotation cell...................................................................... 60

Figure 3-21:

Algae pads from a typical flotation run................................................... 63

Figure 4-1:

Flocculation beaker test results while stirring ......................................... 67

Figure 4-2:

Flocculation beaker test results after settling........................................... 68

Figure 4-3:

Microscope slide results for alum/gelatin chemistries ............................. 69

Figure 4-4:

Microscope slide results for
alum/gelatin/cellulose chemistries .......................................................... 70

Figure 4-5:

Microscope slide results for
iron nitrate/chitosan chemistries ............................................................. 71

Figure 4-6:

Microscope slide results for
iron nitrate/chitosan/cellulose chemistries............................................... 72

Figure 4-7:

Floc to fiber ratio for cellulose chemistries ............................................. 73
xiii

Figure 4-8:

Series of frames in the stationary bubble facility..................................... 75

Figure 4-9:

Frames of the stationary bubble facility for
bubble facility test chemistries................................................................ 76

Figure 4-10:

Series of frames during filling of the suspended
bubble facility ........................................................................................ 79

Figure 4-11:

Frame from filling of the suspended bubble
facility highlighting adsorbed algae ........................................................ 80

Figure 4-12:

Frames of the suspended bubble facility during
filling for bubble facility test chemistries................................................ 81

Figure 4-13:

Series of frames during normal operation
of the suspended bubble facility ............................................................. 82

Figure 4-14:

Frames of the suspended bubble facility during
normal operation for bubble facility test chemistries............................... 83

Figure 4-15:

Algal foam in the EFC during operation ................................................. 86

Figure 4-16:

Algal foam in the EFC after shutdown.................................................... 87

Figure 4-17:

Algae pads generated from the EFC ....................................................... 88

Figure 4-18:

Algae pads generated from the EFC ....................................................... 89

Figure 4-19:

Flotation efficiency in the EFC............................................................... 91

Figure 4-20:

Denver D-12 Flotation Cell during operation.......................................... 93

Figure 4-21:

Algae pads from Denver D-12 Flotation Cell.......................................... 94

Figure 5-1:

Comparison of flocculation beaker images ........................................... 100

Figure 5-2:

Comparison of large and small bubbles in the suspended facility.......... 105

Figure 5-3:

Flotation efficiency vs. average equivalent floc diameter..................... 106
xiv

CHAPTER 1
INTRODUCTION
As the world’s energy needs continue to increase and with oil reserves predicted
to run out sometime this century, development of an alternative energy source is of
paramount importance. Alabama has a unique opportunity to become self sufficient in
liquid fuel production for transportation through algaculture. Alabama could produce its
annual 3 billion gallons of fuel using less than 3% of the state’s land [Putt, 2007].
This thesis addresses harvesting of the green algae chlorella using flotation
processes for use as a feedstock in the production of biofuels. The lipids extracted from
algae can be processed into biofuels. One of the major bottlenecks of biofuel production
from algae is the harvesting step. The algae must be removed from production water and
it must be concentrated before the lipids can be extracted. Algae is at a very dilute
concentration, in the range of a few hundred parts per million when it is ready to be
harvested. The work in this thesis explores flotation as a method to separate chlorella
from water. Chlorella is a very fast growing and robust algae species that thrives in
warm climates such as those of the southeastern United States. With adequate nutrients,
it can double in concentration in 8 hours and has a lipid content between 20-30% by
weight giving it large potential as a feedstock for biofuel [Putt, 2007; Sheehan et al.,
1998].
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Flotation processes are used to separate a suspended species from water, in this
case algae cells or flocs. During flotation, air or another gas is introduced into the water
and suspended particles adsorb to the bubble surfaces. The bubbles then rise to the
surface and create a foam rich in the particles to be separated. The hydrophilic nature of
algal cells makes them respond poorly to flotation processes, and prior attempts at largescale separation of chlorella using flotation have been largely unsuccessful [Putt, 2007].
Addition of flocculants to algae before flotation may lead to an increase in
flotation efficiency. Flocculation is the process of individual cells interacting with one
another to form larger networks of cells called flocs. Larger particles are generally more
conducive to flotation, therefore it is proposed that flocculation of algae prior to flotation
will increase flotation efficiency.
This work focuses on determining appropriate flocculants and flocculant
concentrations to produce large and stable flocs, and then evaluating these systems in
various model flotation facilities. By imaging and observing qualitatively the interactions
of algal cells and flocs with bubble surfaces, this study aims to develop quantification
methods and to identify phenomena that will lead to an effective and efficient algae
flotation process.
Chlorella was grown in the laboratory and in outdoor ponds for use in
experiments.

Qualitative and quantitative flocculation analyses were performed to

determine effective flocculants and flocculant concentrations. Algae floc samples were
imaged using light microscopy techniques to evaluate floc size. Flotation efficiency was
evaluated using a bench scale flotation facility constructed by Dr. Ron Putt to model the
dissolved air flotation process and a Denver D-12 laboratory scale flotation cell to model
2

an induced air flotation process.

Three facilities were used to observe and image

interactions between algal cells and bubbles.

This thesis presents methods and

procedures for capturing high-speed digital video of algal cell and bubble interactions.
This study hypothesizes that imaging techniques may be used to gain valuable insight to
the mechanism of algal cell adhesion to bubble surfaces

3

CHAPTER 2
BACKGROUND
The primary objective of this research was to study algal cell interactions with
bubble surfaces by utilizing existing imaging techniques developed by Davies [2000] and
Emerson et al. [2003] as well as novel laboratory scale flotation apparatuses. The goal of
this study was to develop laboratory scale methods to separate algal cells from water
using flotation processes. More broadly, the objective was to understand flotation of
algae to affect harvesting processes that will increase the potential of algae as a feedstock
for biofuel.
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2.1 Algae as a Feedstock for Biofuel
Due to the ever increasing world demand for oil and the fact that the world’s
supply of oil is finite, avenues for production of alternative renewable sources of energy
are of paramount importance. Biofuels such as biodiesel, green diesel, and ethanol are
currently being explored and produced to meet the worlds expanding energy needs.
Cultivation of micro-algae in the United States as a feedstock for biofuel has the potential
to alleviate the nation’s dependence on foreign oil. The possibility of becoming selfsufficient in energy production via micro-algae cultivation has widespread economical
and environmental impacts.
Micro-algae store energy in the form of carbohydrates and lipids.

Lipids

produced by these algae can be converted into biofuels. Biodiesel or green diesel can be
produced from these algal lipids. Biodiesel is produced via a transesterification reaction
between algal lipids and methanol [Han et al., 2006]. Green diesel is very similar to
traditional petroleum based diesel [Putt, 2007].
The United States Department of Energy’s National Renewable Energy
Laboratory (NREL) first conducted extensive research into algae cultivation for biofuels
in the mid 1970’s, continuing their efforts into the mid 1990’s. The project was known as
the Aquatic Species Program (ASP). The project focused on identifying algal strains
capable of producing a large quantity of lipids and maximizing growth conditions for
lipid production. Many promising strains were isolated and their lipid distributions under
various conditions were characterized. In some algal strains, it was discovered that lipid
production could be as high as 50% by weight [Sheehan et al., 1998].
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After promising algal strains were identified by the ASP, several laboratory and
pilot scale facilities were constructed for feasibility assessments. A facility in Roswell
New Mexico consisting of two 1000 m2 growth ponds was constructed. Several strains
were tested in this facility including tetraselmis suecica and monoraphidium minutum
[Sheehan et al., 1998].

Two important conclusions can be drawn from the tests

performed at this facility. First, only strains native to the area where algal ponds are
located should be used for cultivation.

Each strain tested at the Roswell site was

eventually overrun by native strains. It is too difficult to maintain an alien species in
outdoor growth facilities. Therefore only native species should be used because they will
eventually dominate the pond. Second, location of algal farms should be considered
carefully. Algae production at the Roswell site was considerably reduced during the
winter months due to low temperatures. Algal farms should be located in climatic
regions with an abundance of sunlight, water, and year-round temperature ranges
conducive to algal growth [Sheehan et al., 1998]. Regions in the southeastern United
States, including Alabama, meet these requirements [Putt, 2007].
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2.2 Chlorella as a Feedstock for Biofuel
The genus of green algae chlorella is a strong candidate for algae farming in the
southeastern United States for production of biofuel. Chlorella cells are spherical in
shape with cellular diameters ranging from 2-10 microns.
conditions, chlorella reproduces very quickly.

Under nominal growth

Cell concentrations are capable of

doubling in 8 hours [Putt, 2007]. Chlorella requires only sunlight, carbon dioxide, and
small amounts of minerals such as phosphate and nitrogen to reproduce. Chlorella is also
attractive for mass production because photosynthetic efficiency can theoretically
approach 8% [Morita et al., 2001]. For comparison, the photosynthetic efficiency of
most trees is about 0.5% and solar panels are typically 10-20%. The lipid content of
chlorella is typically 20% by weight of the dried cell mass [Sheehan et al., 1998]. Figure
2-1 is a micrograph of a chlorella vulgaris cell [Stead et al., 1995].
There are several factors that make chlorella an attractive candidate for algae
farming in the southeastern U.S. and particularly Alabama.

Chlorella is native to

Alabama and is found naturally growing throughout the state. Attempts to cultivate alien
strains would likely be overtaken by chlorella. The lipid content is sufficiently high that
cost effective production of biofuel could be realized. Alabama has a large amount of
available land and water suitable for chlorella algae production. Lastly, the climate is
conducive to year round growth of chlorella. Production during the winter months of
January and February and the summer month of July may be reduced but still possible
[Putt, 2007].
Harvesting of micro-algae presents a difficult challenge. The concentration of
algae during the harvesting stage is very small, on the order of a few hundred ppm.
7

Separation of the algae from the water in such dilute concentrations can be problematic.
Filtration systems have been successfully implemented for harvesting of algae [Hung and
Liu, 2006], however they require a large throughput and are prone to blinding. Settling
tanks are a second option in which the algae is allowed to settle to the bottom of a
quiescent pond in series with the growth pond. The water above the algae is then
removed leaving a concentrated algal mass on the bottom of the pond. This approach
requires separate settling tanks which can double the amount of required land. The
process also takes several days, leading to a highly inefficient process. This study is
focused on flotation of algae as an alternative algae harvesting technique.
After harvesting, the lipids can be removed from the algae in a solid-liquid
extraction process similar to those employed to separate soybean oil from the bean. The
algal lipids can then be processed into biofuels. The remaining algal meal after lipid
removal is very rich in protein and can be used as an animal feed. Discussion of the
conversion of harvested algae to biofuels can be found in Han et al. [2006].
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Figure 2-1: TEM micrograph of an individual chlorella cell [Stead et al., 1995].
c-chloroplast, p-pyrendoid, n-nucleus, and cw-cell wall.
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2.3 Induced and Dissolved Air Flotation
Flotation is a process that utilizes gas bubbles (typically air) to separate particles
from a liquid. Flotation was first used in the mineralogical industry to separate mineral
ore from water. It is also commonly employed in the paper recycling industry to remove
contaminants from recycled paper. During flotation, air bubbles rising through a liquid
collect particles that then rise to the surface of the water with the bubbles. The bubbles
create a foam at the surface of the water which is skimmed off. Flocculants or coagulants
are often added to the feed water to flocculate contaminants. The contaminant flocs are
more conducive to flotation. There are two main types of flotation processes, induced air
flotation and dissolved air flotation (DAF).
Induced air flotation, also know as froth flotation, utilizes air bubbles injected into
the vessel containing the liquid to be clarified. Air can be injected through the bottom of
the vessel with a gas sparger or entrained via cavitation. Contaminants contacted by
rising bubbles are adsorbed to the bubble surface and travel to the water surface with the
bubbles. The bubbles form a contaminant rich foam on the surface of the water. The
foam is then skimmed off to separate the contaminants from the clarified water. Bubble
diameters in induced air flotation cells are typically between 1 and 2 mm. These units are
typically employed to remove larger contaminants.

Froth flotation cells are often

operated in series to achieve a desired level of contaminant removal. Figure 2-2 is a
schematic of a Voith Sulzer EcoCell froth flotation unit [Martin and Britz, 1996].
Dissolved air flotation is similar to induced air flotation in that rising bubbles
contact contaminants that rise to the surface and form a foam. The primary difference
between dissolved and induced air flotation is the method air bubbles are generated. In
10

DAF, the contaminated water to be clarified is pressurized. Air is sparged into the
pressurized stream until the water is saturated with air at the elevated pressure. The
saturated water is then depressurized in the flotation cell. The pressure drop causes the
saturated air to come out of solution as tiny air bubbles. These bubbles are smaller than
those produced in induced air flotation. Typical bubble diameters range from 0.05-0.7
mm. Contaminants adsorb to the bubbles in the same manner as in induced air flotation
and form a foam on top of the water. The foam is then skimmed to separate the
contaminants from the water.

DAF is more expensive to operate than induced air

flotation because of the pressurization step. It is used to remove smaller contaminants.
Figure 2-3 is a schematic diagram of a typical DAF cell [Biermann, 1996].
The induced air flotation and DAF cells and processes that may be used for algae
are likely to be similar to those described here that are established for paper recycling and
deinking processes.

Yao-de and Jameson [2003] have studied algae flotation from

wastewater maturation ponds utilizing Jameson flotation cell technologies. Bench scale
and pilot scale experiments were used to validate the technology.

They have

demonstrated that algal removal can approach 99% in a full-scale implementation facility
in Wagga Wagga, Australia [Yao-de and Jameson, 2003].

Jameson flotation cell

technologies for algal flotation are also discussed in Jameson [1999]. Harvesting algae
via froth flotation technology is discussed in Levin et al. [1961], Chen et al. [1998], and
Liu et al. [1999, 2007]. DAF flotation principles are discussed in Rodrigues and Rubio
[2007].
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Figure 2-2: Voith Sulzer Eco Flotation Cell [Martin and Britz, 1996].
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Figure 2-3: Dissolved air flotation cell [Biermann, 1996].
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2.4 Flocculation of Algae
Flocculation is the process in which a solute or suspended particles in a solution
clump together to form a larger agglomerate referred to as a floc. Algal flocculation
describes the process in which individual algae cells or groups of cells clump together to
form an algae floc. Algae flocs are typically unstable and easily disturbed. Agitation of
flocs will cause them to break apart into smaller flocs or individual cells. Flocculants are
chemicals that induce flocculation.
Flocculants are typically multivalent cations such as alum or iron chlorides or
sulfates. These positively charged cations interact with the surface of algae cells, which
typically carry a negative charge. This charge mediation allows cells to interact and form
flocs. The cell walls of green algae are very hydrophilic in nature. This hydrophilic
nature is not very conducive to flotation [Yao-de and Jameson, 2003]. Charge mediation
through flocculation may help to reduce the hydrophilic nature of the cell walls and
increase the effectiveness of flotation. Bilanovic and Shelef [1988] have shown that
salinity is an important factor governing flocculation. Increasing ionic strength lead to
decreased flocculation effectiveness for chitosan, indicating that marine algal species
could be more difficult to flocculate [Bilanovic and Shelef, 1988].
Several naturally occurring biological polymers are known to induce flocculation,
chief among these are chitosan [Kivakaran and Pillai, 2002] and gelatin [Kragh and
Langston, 1961]. Chitosan is derived from chitin, the primary structural element in the
exoskeleton of crustaceans [Planas, 2002]. Chitosan is produced by deacetylation of
chitin, forming a high molecular weight polymer.

Figure 2-4 shows the chemical

structure of chitin and chitosan. The amino group interacts with the negatively charged
14

surface of algae cells [Planas, 2002]. Gelatin is derived from the connective tissue and
bones of animals such as cattle, pigs, and horses. Algae may spontaneously flocculate
without the addition of any flocculants. This process is known as auto-flocculation.
Algae that is several days old will often auto-flocculate [Oh et al., 2001; Alonso et al.,
2000].

15

(a)

(b)

Figure 2-4: Structure of chitin (a) and chitosan (b) [Planas, 2002].
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CHAPTER 3
EXPERIMENTAL PROCEDURES AND EXPERIMENTS
The goal of this research was to visualize algal cell and bubble interactions to
further understand the process of algal flotation. In order to evaluate viable flocculation
chemistries to be tested for flotation, several flocculants were examined in various
concentrations and the resulting flocs were imaged under a microscope. The average
equivalent floc diameter was determined for each chemistry tested. After screening for
viable flocculation chemistries, algal cell and bubble interactions were imaged in three
facilities. The suspended bubble facility suspends a bubble on the tip of a needle in a
quiescent fluid and algae is injected onto the bubble. The suspended bubble facility
suspends a bubble in a down flow of water allowing visualization of algae floc and
bubble collisions. The EFC is an electrochemical flotation cell used to evaluate the
flotation efficiency of each flocculation chemistry tested.

17

3.1 Algal Culture
The chlorella algae samples used in this work were obtained from outdoor algae
growth ponds used in the research program of Dr. Ron Putt. Dr. Putt utilized two
concrete outdoor growth ponds at the North Auburn Fisheries Unit. The ponds measured
2.75 x 7.6 m and were filled with water to a depth of 20 cm. The water was pumped
from Farm Pond 11, which is the Auburn Fisheries station reservoir that collects
rainwater from the local watershed. Pond algae was established from an inoculum of
chlorella and supplied nutrients from 5 gallons of poultry litter. A paddlewheel and
center walls provided mixing in the system. Figure 3-1 is a photograph of one of the
outdoor growth ponds.

Dr. Ron Putt developed a relationship between algal

concentration and light transmittance at 550 nm. Algae concentration was measured in
the suspension via centrifugation, drying, and weighing the algal mass [Putt, 2007].
In order to maintain a consistent stock of algae for experiments, an indoor
chlorella culture was established in the laboratory. Two 25 gallon black plastic tanks
were filled with 15 gallons of tap water and allowed to come to room temperature. Each
tank was agitated with a submergible fountain pump manufactured by Garden Treasures
model MD170. Pumps were magnetic drive pumps with a range of 130-170 gph, 0.5 inch
outlet diameter, 120 V, 60 Hz, 11 W, with maximum pumping head of 3.5 ft. Pumps
were attached in the center of each tank bed via rubber suction cups and set to the
maximum of 170 gph. Per the manufacturer’s instructions, 7.5 mL of ammonia and
chloramine remover (Jungle Laboratories) was added to each tank. One tablespoon of
all-purpose plant food manufactured by Expert Gardener was dissolved in 1 cup of
distilled water and added to each tank. An 18 inch fluorescent light bulb was mounted on
18

a Unistrut support over each tank. Each light bulb was controlled with a timer and set to
a 15 hour light/9 hour dark cycle. Room lights were also turned off during the dark cycle
each night. Initially each tank was illuminated with a different bulb. Tank A was lit by
an 18 inch, 15 W GE AquaRays 9325K aquarium light bulb and Tank B was lit by an 18
inch, 15 W Tropic Sun 5500K light bulb. Each bulb was designed to simulate the
ultraviolet spectrum of natural sunlight. (Algae growth was greater for the tank with the
Tropic Sun bulb, thus the GE bulb was replaced with a Tropic Sun bulb.) Each tank was
allowed to equilibrate for 24 hours.
After 24 hours 2 gallons of algae inoculum supplied from Dr. Ron Putt’s outdoor
pond at a concentration of 300 ppm was transferred to Tank A. The inoculum, contained
in 2 one-gallon containers, was immersed in the tank to allow the temperature to
equilibrate. After 30 minutes the inoculum was transferred to the tank. After two days, 2
gallons of the algae in Tank A was transferred to 2 one-gallon containers and allowed to
equilibrate in the second tank. After 30 minutes the algae in the 2 containers was
released into Tank B.
After inoculation, the pH, temperature, and Secchi depth of each tank was
monitored every day.

The Secchi depth provides a quick estimate of the algae

concentration. A Secchi disk was constructed by mounting a circular white plastic lid to
a wooden dowel. The dowel was marked with a ruler in 0.5 cm increments. The disk is
inserted into the algae and a distance measurement is taken when the disk is no longer
visible.

Dr. Putt developed a relationship between the Secchi depth and the algae

concentration via measurements with a spectrophotometer. Algae concentration was
monitored periodically via the transmittance correlation developed by Dr. Ron Putt using
19

a Milton Roy Spectronic 20D spectrophotometer. The transmittance correlation is shown
in Figure 3-2. De-chlorinated tap water was added to the tanks as needed when the water
level dropped as the algae was used for experiments. If the pH fell below 7, sodium
bicarbonate was added to the tank in order to maintain the pH in the optimal growth
range of 7-9 [Mayo and Noike, 1994]. Figure 3-3 is an image of the indoor growth tanks;
the water level is low because the photograph was taken just after samples were removed
for experiments.
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Figure 3-1: Outdoor algal growth pond.
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Figure 3-2: Relationship between algal concentration and transmittance at
550 nm. Data obtained by Dr. Ron Putt.
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Figure 3-3: Indoor algal growth tanks.
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3.2 Chemicals
Several flocculating agents were employed.

Ferric nitrate nonahydrate was

purchased from Fisher Scientific. Solid ferric nitrate was dissolved in distilled water to
obtain a 10,000 parts per million by mass (ppm) stock solution. Aluminum sulfate
16·H2O (alum) was purchased from Fisher Scientific. Solid alum was dissolved in
distilled water to obtain a 10,000 ppm stock solution. Powdered chitosan, MW 100,000–
300,000 Da was purchased from Argos chemicals. Stock solution was prepared by
dissolving 100 mg in 10 mL of 1 N hydrochloric acid and allowed to stir for 30 minutes.
This solution was added to 90 mL of distilled water to obtain a 1000 ppm stock solution.
Gelatin from an animal source, MW 100,000–300,000 Da was purchased from Fisher
Scientific. Stock solution was prepared by adding 50 mg of gelatin to 100 mL of distilled
water heated to 60 °C on a hot plate and allowed to stir for 2 hours to obtain a
concentration of 500 ppm.
The indoor chlorella growth tanks were supplied one tablespoon of Expert
Gardener’s all-purpose plant food dissolved in 1 cup of water once a week. This plant
food has a nitrogen-phosphorous-potassium distribution of 24-8-16. Tap water used in
the growth tanks was treated with Jungle Pond ammonia and chloramine remover.
Sodium bicarbonate purchased from Sigma-Aldrich was used to control the pH of the
growth tanks. The pH of each experimental condition was controlled using 0.05 M
hydrochloric acid (HCl) and sodium hydroxide (NaOH) purchased from Fisher Scientific.
Cellulose stock was prepared by mixing copier paper with water and was repulped in a household blender to obtain a 5% by weight stock solution of cellulose fibers.
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3.3 Stir Plate Calibration
To standardize experimental procedures for the flocculation beaker tests
(described in section 3.4) it was necessary to calibrate the magnetic stir plate used in
these studies. A standard magnetic stir plate manufactured by Fisher Scientific (model
210T) was used to stir algae samples with a 1 inch octagonal stir bar manufactured by
Fisher Scientific. A relationship between the speed setting and the velocity in the fluid
was developed.
One side of the stir bar was marked for reference and placed on the stir plate. The
stir bar was filmed in motion for 4 stir plate settings with a high-speed camera recording
at 500 frames per second (FPS). By observing the resulting video, the number of frames
per 1 revolution of the stir bar was measured. Using the frame rate, the revolutions per
minute (RPM) of the stir bar was calculated.
To verify the results of the high-speed video, the RPM of the stir bar was also
measured with a Monarch Instruments Nova-Strobe DA/DB strobe light. The stir bar
was observed under the strobe with the room lights turned off for each of the
manufacturer’s stir plate settings. The frequency of the strobe light was adjusted until the
stir bar appeared to stop moving, making sure that the mark on the stir bar stayed in the
same position. This frequency was recorded for comparison with the high-speed movies.
The stir bar was also observed under the strobe while spinning in 200 mL of distilled
water placed in a 250 mL Pyrex beaker used in the flocculation beaker test studies.
The angular velocity measured with the strobe light and high-speed videos was
used to calculate the linear velocity for any stir plate setting in a 250 mL beaker at a
distance of 2/3 the radius of the beaker. This velocity is denoted the two-thirds velocity
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(TTV). Equation 3-1 was used to determine the TTV. A typical rising air bubble in
water has a rise velocity of about 1 ft/sec [Clift et al., 2005]. To simulate these velocities
in our studies, the stir plate setting was adjusted to give a TTV of 1 ft/sec. The Reynolds
number of mixing (Remix) was defined in Equation 3-2 and calculated for each stir plate
setting. The relationship between the stir plate setting and the TTV is shown in Figure 34.

Equation 3-1

TTV =

Equation 3-2

Re mix =

2
! RPS ! R
3

Dbar " RPS " ! water
µ water

R = Radius of the beaker (0.2083 ft)
Dbar = Diameter of the stir bar (0.0254 m)
RPS = Revolutions per second of the stir bar
kg
ρwater = Density of water at 20 ˚C (998.2 3 )
m
µwater = Viscosity of water at 20 ˚C (0.001002 Pa·s)
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Figure 3-4: Fisher stir plate 210T calibration curve.
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3.4 Flocculation Beaker Tests
The flotation process often employs the use of flocculants or coagulants to
increase the size of particles to be floated, resulting in enhanced flotation efficiency
[Rodrigues and Rubio, 2007]. A qualitative and semi-quantitative method for evaluating
the ability of ferric nitrate, alum, chitosan, gelatin, and cellulose to flocculate algae alone
and in combination was developed. Table 3-1 shows 33 combinations of concentrations
of additives that were tested. All runs were performed at 22 °C and pH 7.
Algae stock for these experiments was taken from Tank A and stirred throughout
the experiments at room temperature (22 °C). The pH of the stock algae was adjusted to
7 with 0.05 M HCl and NaOH and monitored throughout the experiment.
Images of the algae flocs in the stirred beaker for each run were taken with a
Nikon D-40x camera with a Nikon G-Type AF-S DX lens operated in manual mode. The
camera was mounted on a rail system to ensure the same field of view and scale for each
image. The camera was mounted 16.5 cm from the edge of a breadboard (seventh row).
The breadboard was positioned against the Fisher stir plate; the stir plate calibration
procedure is described in section 3.3. A white piece of display board was positioned
vertically behind the stir plate for background. Lighting was provided by a standard desk
lamp with a 75 W bulb on the left side of the stir plate and a clamp lamp with a 75 W
bulb on the right side. To find the center of the stir plate, a stir bar was placed on the
plate and allowed to come to rest in the middle. Target guidelines to mark the center of
the plate were marked with a permanent marker. A metal 150 mm ruler was positioned
vertically and held in place with a ring stand and clamp on the left side of the stir plate

28

positioned on the center guide mark parallel to the breadboard. The camera lens zoom
was set to 35 and was focused manually on the ruler.
For each run, 200 mL of the algae stock was transferred to a 250 mL Pyrex beaker
containing a Fisher 1 inch octagonal stir bar. The beaker was placed in the middle of the
target guideline on the stir plate. The stir plate was set to 6 corresponding to a TTV of
about 1 ft/sec. The algae was allowed to stir for 1 minute allowing the flow pattern to
develop. After 1 minute the appropriate amount of the primary flocculant (iron nitrate or
alum) was added with a pipette to a point 2/3 from the center of the beaker and the
solution was allowed to stir for 15 seconds. After 15 seconds, the appropriate amount of
the secondary flocculant (chitosan or gelatin) was added at the same location. The
solution was allowed to stir for an additional minute. After 1 minute an image was taken
with the Nikon D40x on the rail and visual observations were recorded.

For runs

containing cellulose, the appropriate amount of cellulose was first added to the algae
sample and allowed to stir on the stir plate on setting 10 until the cellulose was evenly
dispersed.
After the image was taken, as quickly as possible a small volume of the
flocculated algae was taken from the sample using a disposable plastic pipette. The end
of the pipette was cut to enlarge the opening to minimize disruption of the algae flocs.
The sample was transferred to the center of a glass microscope slide and was covered
with a plastic cover slip for further analysis. Figure 3-5 is an image of a typical beaker
test run one minute after the addition of the secondary flocculant. After the image and
microscope slide samples were taken, the stir plate was switched off and the sample was
allowed to settle for 15 minutes. After settling, a second image of the flocculated and
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settled sample was taken. Figure 3-6 is an image of a typical beaker test run after 15
minutes of settling.
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Table 3-1: Flocculation beaker test run chemistries.
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Figure 3-5: Typical flocculation beaker test 1 minute after addition of secondary
flocculant. Corresponds to iron nitrate and chitosan concentrations of 50 ppm and
1.25 ppm respectively.
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Figure 3-6: Typical flocculation beaker test after 15 minutes of settling.
Corresponds to iron nitrate and chitosan concentrations of 50 ppm and 1.25 ppm
respectively.
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3.5 Microscope Slide Photographs
As was described in section 3.4, algae samples were extracted from stirred
solutions in beakers and placed on microscope slides. The samples from the flocculation
beaker tests summarized in Table 3-1 presented in section 3.4 were analyzed by a
microscope to determine the average floc size for each chemistry. Each slide was imaged
under a microscope with the Nikon D40x digital camera. Slides were mounted on a
Macromaster CK microscope manufactured by Fisher Scientific. The right eyepiece was
fitted with a microscope camera adapter system. The telescoping portion of the camera
adapter was set to its longest position to reduce vignetting. The adjustable eyepieces
were set as far apart as possible for all images. The camera was connected to a video
monitor.
Ten images at 10 times (10x) magnification (low mag) as well as ten at 40 times
(40x) magnification (high mag) were taken of each microscope slide sample. For each
image the camera was operated in manual mode. The shutter speed for all low mag
images was set to 130 sec-1 and 13 sec-1 for all high mag images. Scale was established
by imaging a 2 mm ruler with 100 µm major divisions and 10 µm minor divisions
mounted on a microscope slide. The focus was kept in the same position while imaging
the algae samples to maintain the same scale. Images of a USAF 1951 resolution target
were also taken. Figures 3-7 and 3-8 are images of a typical floc under low and high
magnification with the corresponding scale images of the ruler and resolution target, the
iron nitrate and chitosan concentrations for these samples were 50 ppm and 1.25 ppm
respectively.
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Average floc area was determined quantitatively using a blob analysis technique
similar to that used by Emerson et al. [2006]. ImageJ, shareware developed at the
National Institutes of Health, was used for blob analysis. The average number of pixels
of 30 distance measurements on images of the ruler was used to establish a pixels/µm
scale for the algae samples. For each algae sample image, the area of each floc (Afloc)
was traced with the ImageJ polygon tool and the area in µm2 was recorded. Only flocs
whose entire area was visible in an image were measured. A floc thickness of 10 µm
(tfloc) was assumed to calculate an average equivalent diameter of the flocs. Visual
observation of many flocs under the microscope showed that most flocs were about two
algae cells deep. Based on an average chlorella cell diameter of 5 µm [Stead et al.,
1995], two cells deep would indicate a floc depth of about 10 µm. The area reported by
ImageJ and the assumed thickness were used to calculate a floc volume. This volume
was converted to an equivalent diameter of a sphere with the same volume (Dfloc) with
Equation 3-3. Refer to Appendix A for a detailed description of the blob analysis
procedure.

Equation 3-3

D floc = 2 " 3

4 " A floc " t floc
3"!

For runs containing cellulose, the area of cellulose fibers attached to algae flocs
was measured. A floc to fiber ratio was determined as the area of algae flocs attached to
a cellulose fiber, divided by the area of the cellulose fiber. Figure 3-9 is an image of
algae flocs attached to a cellulose fiber corresponding to iron nitrate and chitosan
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concentrations of 50 ppm and 1.25 ppm respectively and a cellulose to algae mass ratio of
1:1.
Samples of fresh algae and cellulose with no added flocculants were prepared.
Images at 100 times (100x) magnification and 40 times (40x) magnification with
corresponding scale images were taken. Figure 3-10 is an image of fresh algae and
cellulose along with a corresponding scale image at 100x.
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Figure 3-7: Low magnification (10x) microscope images of (a) typical floc, (b)
ruler scale, and (c) resolution target. Corresponds to iron nitrate and chitosan
concentrations of 50 ppm and 1.25 ppm respectively.

37

Figure 3-8: High magnification (40x) microscope images of (a) typical floc,
(b) ruler scale, and (c) resolution target. Corresponds to iron nitrate and
chitosan concentrations of 50 ppm and 1.25 ppm respectively.
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Figure 3-9: Low magnification (10x) microscope images of (a) typical floc
with cellulose, (b) ruler scale, and (c) resolution target. Corresponds to iron
nitrate and chitosan concentrations of 50 ppm and 1.25 ppm respectively and a 1:1
cellulose to algae mass ratio.
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Figure 3-10: High magnification (100x) microscope images of (a) fresh
algae, (b) clean cellulose, and (c) ruler scale.
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3.6 Stationary Bubble Facility
The stationary bubble facility was originally constructed in 1998 by Andrew
Davies and Duke [2000] to study the interaction of ink particles with air bubbles. The
stationary bubble facility was employed in this work to study the interaction of algal cells
with stationary bubbles suspended on the tip of a needle in a quiescent fluid. Imaging
algae absorption to stationary bubbles removes many of the difficulties associated with
imaging absorption to a moving bubble in a flow field.
The stationary bubble facility consists of a luer lock needle connected to a check
valve. The check valve is attached via ¼ inch stainless steel tubing and soft-wall tygon
tubing to a 50 mL Hamilton gas tight syringe. The needle is placed in a clear hexagonal
vessel containing a quiescent fluid. Air is introduced into the line slowly by hand until an
air bubble is suspended on the tip of the needle. Algal cells or flocs are injected from a
plastic disposable pipette whose end has been widened to minimize disturbing flocs. The
pipette is directed such that the injection strikes the top surface of the stationary bubble.
The injection event is recorded with a high-speed CCD video camera with a high
magnification lens. Figure 3-11 is a diagram of the stationary bubble facility and Figure
3-12 is an image of the facility. Figure 3-13 is a typical frame captured by the CCD
camera depicting a suspended bubble. Prior to each test run, a few frames of a ruler were
captured in the field of view to establish scale.
Algal cell and bubble interactions in water were studied over a pH range of 2–10
in 0.5 increments. Algal cell and bubble interactions in water were studied over a
temperature range of 10-50 °C in 10 °C increments. Interaction between air bubbles and
algae that had been flocculated were observed. Based on the 33 chemistries evaluated in
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the beaker tests described in section 3.4, seven flocculation chemistries were selected for
further study. These seven chemistries are presented in Table 3-2. Each run in Table 3-2
was conducted at pH 7 and room temperature of 22 °C. The pH was adjusted with 0.05
M HCl and NaOH. For those runs containing cellulose, the appropriate amount of
cellulose was first dispersed in the hexagonal vessel containing the test solution via a 1
inch magnetic stir bar on a stir plate at the highest setting.
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Figure 3-11: Schematic of the stationary bubble facility. Adapted from Ham
[2004].

43

Figure 3-12: Stationary bubble facility.
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Figure 3-13: Typical frame from the stationary bubble facility.
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Table 3-2: Chemistries tested in the bubble facilities.
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3.7 Suspended Bubble Facility
Rossi [1998] constructed the suspended bubble facility in 1998 and it has been
used extensively for study of ink interactions with bubbles. Bubbles are suspended in a
vertical tube by a controlled flow of fluid. The viewing tube is constructed of Plexiglas
to allow visualization of the process. The facility is about 2.75 m tall and can hold 7.5 L
of fluid. Figure 3-14 is a diagram of the suspended bubble facility and Figure 3-15 is an
image of the facility.
The Plexiglas viewing tube is secured with flanges allowing interchange of
varying diameter viewing tubes. A 1/8 horsepower Fasco magnetic drive pump rated at
3000 RPM drives the fluid in the loop. It can deliver up to 53 LPM under 0.93 m of
head. Cole-Palmer rotometers are used to monitor the flowrate through the system. They
are polysolfanone direct-reading-in-line rotometers with 316 steel floats. There are three
flow meters in parallel capable of measuring 0.379-3.79 LPM, 0.758-7.58 LPM, and
7.58-75.8 LPM. Air is injected via a compressed air source at the bottom of the Plexiglas
viewing chamber through a luer lock needle. The size of the bubbles is affected by the
flow rate of air introduced to the system and the diameter of the needle orifice. Bubbles
are prevented from reaching the pump by traveling into a holding chamber located above
the viewing chamber. There are several vertical 0.64 cm tubes at the bottom of the
holding chamber to reduce turbulence of the flow entering the column. Fully developed
flow is achieved at a distance of about 0.3 m downstream of the entrance, calculated by
Davies and Duke [2000]. Images are recorded 43 cm above the air injection point to
ensure fully developed pipe flow.
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For each test run in the suspended bubble facility, 7.5 L of algae from Tank A at a
concentration of 150 ppm was stirred in a stainless steel bucket. The pH was adjusted to
7 with 0.05 M HCl and NaOH. The seven chemistries in Table 3-2 were tested in the
facility. The appropriate chemicals were added to the stock algae in the same manner
described in the beaker test experiments in section 3.4.

The solution was quickly

transferred from the bucket to the flow loop. Video was taken during startup (while the
facility was being filled) of each run at 500 FPS with the high-speed camera. After the
facility was loaded with the test solution the pump was turned on and bubbles were
injected through the needle. The bubbles were suspended within the camera’s field of
view by adjusting the flow control valves. Video of the process was recorded with the
high-speed camera at 500 FPS.
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Figure 3-14: Schematic of the suspended bubble facility [Ham, 2004].
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Figure 3-15: Suspended bubble facility.
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3.8 Electrochemical Flotation Cell
The diameter of bubbles in the flotation process is a key parameter; typically
smaller bubbles float contaminants more effectively and efficiently [Cassell et al., 1975].
The flotation scenario for large bubbles in induced air flotation is often several flocs or
particles attached to a single bubble; the scenario for small bubbles in DAF flotation is
several small bubbles attached to a single floc. It is very difficult to produce bubbles
smaller than about 750 µm utilizing induced air flotation methods.

Therefore, to

determine the effect of smaller bubbles on algae flotation, we have used a small
electrochemical flotation cell (EFC) that generates small hydrogen gas bubbles for
flotation. The size of the bubbles can be controlled by varying the current supplied to the
fuel cell. The EFC was developed by Dr. Ron Putt at Auburn University [Putt, 2007].
The EFC consists of a flotation chamber and a collection basin, supported by 4
plastic legs. The flotation chamber is filled with algae to be separated. Hydrogen
bubbles produced in the flotation chamber rise to the surface carrying adsorbed algae and
form an algal foam. Algal foam builds on the surface of the flotation chamber and spills
into the collection basin thus separating the algae from the water. Figure 3-16 is a
schematic of the EFC and Figure 3-17 is an image of the cell.
A hydrogen atmosphere is created under the flotation chamber by a bench scale
fuel cell. Smaller hydrogen bubbles are produced in the flotation chamber by a high
carbon surface area Nafion membrane with a 1% platinum catalyst. The hydrogen gas
produced by the fuel cell is pumped under the flotation chamber where it contacts the
anode of the Nafion membrane. The hydrogen gas is oxidized at the anode and protons
passes through the membrane due to a voltage difference generated by connecting a D
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battery across the membrane. The protons are reduced at the cathode and form small
hydrogen bubbles that rise through the flotation chamber. The D battery is attached to
screws in contact with the anode and cathode via alligator clips.
The seven chemistries listed in Table 3-2 were studied in the EFC.
condition was tested twice.

Each

Stock algae was supplied from Tank A and stirred

throughout the experiment. The pH of the algae stock was adjusted to 7 with 0.05 M HCl
and NaOH. Prior to each run, the fuel cell was loaded with distilled water and allowed to
operate for 10 minutes to build up a hydrogen atmosphere under the facility. The fuel
cell was supplied with 2 V of power, corresponding to 0.5 A of current through the cell.
For each run, 650 mL of algae was transferred to a 2 L glass beaker and stirred with a 1
inch octagonal Fisher stir bar on the Fisher stir plate on setting 6. The appropriate
amount of flocculants for each run were added in the same manner described in section
3.4 and the algae was transferred to the EFC. The D cell battery was connected and the
EFC was operated for 5 minutes.
After 1 minute had elapsed, video recorded at 500 FPS with the high-speed
camera was taken with the camera focused on a point 2 cm from the front of the vessel
and 2 cm from the top of the water level. A few frames of a ruler were taken before each
run to establish scale. A second video was recorded after 4 minutes had elapsed, with the
camera focused on a point 2 cm from the front of the vessel and at the water line. Images
of the foam were taken throughout the experiment. Figure 3-18 is an image of the foam
generated in a typical run, corresponding to iron nitrate and chitosan concentrations of 50
ppm and 1.25 ppm respectively.
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After 5 minutes had elapsed, the D cell battery and the power to the fuel cell were
disconnected. The foam was collected with a flat rectangular piece of glass that had been
cut to just fit in the facility. The foam was skimmed with this piece of glass 8 times,
twice from each side of the vessel, spilling the foam into the collection basin. The
collected foam was transferred to a 50 mL Pyrex beaker and the remaining water in the
facility was transferred to a 2 L Pyrex beaker. Algae pads were generated from the
collected foam and the water remaining in the facility. The procedure for constructing
algae pads is described in section 3.10.
The EFC can be set up to produce either hydrogen or air bubbles. Both gases
were used to determine the effects of gas type on flotation. Four 1 inch aeration stones
were placed in the bottom corners of the facility. Air was pumped to these stones with a
standard small aquarium pump. Air bubbles produced in the EFC are in the range of 1-4
mm while hydrogen bubbles are in the range of 25-500 µm. Each condition in Table 3-2
was tested with air as well as hydrogen.
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Top View

Figure 3-16: Schematic of the EFC.
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Figure 3-17: Electrochemical flotation cell. (a) Top view, (b) bottom view, and
(c) front view.
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Figure 3-18: Algae foam generated in the EFC. Corresponds to iron
nitrate and chitosan concentrations of 50 ppm and 1.25 ppm respectively.

56

3.9 Denver D-12 Flotation Cell
The Denver D-12 flotation cell manufactured by Svedala Industries is a laboratory
scale flotation device used to model industrial induced air flotation processes. The
Denver Cell was used to evaluate the seven chemistries listed in Table 3-2.
An aluminum column situated on a cast iron base supports the Cell. The height of
the column is adjusted via a suspended type mechanism fitted with an enclosed antifriction spindle bearing stainless-steel shaft. The suspended type mechanism is raised or
lowered with a hand crank located on the side of the cell. The mechanism will lock in
any position by releasing a spring-loaded pin. This pin must be pulled while adjusting
the height of the column. Air is pulled into the machine via cavitation producing bubbles
for flotation. The volume of air is related to the RPM of the motor. There are 2 plastic
fluidizers and 2 plastic impellor sizes. The smaller fluidizer and impellor were used for
all experiments. The cell is driven by a ½ horsepower, 900-1800 RPM, single phase, 60
Hz, 115/230 V, TEFC ball bearing motor. The motor speed is controlled by a knob on
the top of the column and monitored via a mounted tachometer. Test samples are loaded
in a stainless-steel vessel mounted under the diffuser. The machine is capable of testing
samples of 250, 500, 1000, and 2000 g. The 250 g vessel was used for all experiments.
Figure 3-19 is a schematic of the Denver Cell and Figure 3-20 is an image of the cell
[Svedala, 1996].
The procedure employed for the Denver Cell was similar to that of the EFC. For
each run the 250 g stainless-steel vessel was used and the machine was operated at 900
RPM for 5 minutes using the smaller impellor and fluidizer. Algae pads described in
section 3.10 were constructed from collected foam, and images of the foam produced
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were taken throughout the experiments. It was not possible to generate algae pads from
the remaining water in the Denver Cell after each run due to blinding of the filter paper
during filtration.
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Figure 3-19: Denver D-12 Flotation Cell [Svedala, 1996].
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Figure 3-20: Denver D-12 Flotation Cell.
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3.10 Algae Pads
Algae pads were constructed from samples generated in the EFC and the Denver
D-12 Flotation Cell to determine the mass of algae in the foam layer and thus the
flotation efficiency. The method involves producing dried algae cakes on filter paper
substrates from the collected foam as well as unfloated algae in the clarified water of the
flotation runs.
For each flotation run, 2 pieces of filter paper were dried in an oven at 65 °C for 4
hours to remove moisture. The filter paper was removed from the oven and the dry
weight was immediately recorded. The filter paper was transferred to a Büchner funnel
attached to a vacuum pump. The filter paper was wetted with distilled water and the
vacuum pump was turned on to provide suction to the funnel. Algae samples from
flotation runs were filtered through the funnel producing an algae cake on the filter paper.
Algae from collected foam was collected on 7 cm diameter filter paper. Unfloated algae
from flotation runs was collected on 11 cm diameter filter paper. Algae pads were
removed from the filter and transferred to an oven at 65 °C and allowed to dry for 24
hours. After 24 hours the algae pads were removed from the oven and immediately
weighed. Images of each algae pad were taken after drying. Figure 3-21 is an image of
algae pads produced from algae collected from the foam and unfloated algae from a
typical flotation run, corresponding to iron nitrate and chitosan concentrations of 50 ppm
and 1.25 ppm respectively.
A quantitative measure of the flotation efficiency was calculated from the weight
of the algae pads. The total mass of algae and added chemicals collected on a given pad
was calculated as the difference in the final and initial weight of each algae pad. In order
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to account for the weight that flocculants and cellulose added to the algae pads, it was
assumed that all added chemicals were bound to the algae.

The amount of added

chemicals in the foam and the amount remaining bound to the unfloated algae was then
proportional to the amount of algae floated. For example, for a run containing 50 mg
total of algae and 20 mg of additional chemicals total, if 40 mg of algae were collected in
the foam and 10 mg remained unfloated, then it was assumed that 16 mg of added
chemicals were present in the foam with the remaining 4 mg bound to the unfloated
algae. Flotation efficiency was defined as the difference between the total mass of algae
at the start of the run and the mass of unfloated algae, divided by the total mass of algae
at the start of the run.
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Figure 3-21: Algae pads generated from a typical flotation run. (a) Algae from
collected foam and (b) unfloated algae. Corresponds to iron nitrate and chitosan
concentrations of 50 ppm and 1.25 ppm respectively.
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3.11 Imaging System
The high-speed camera utilized in this study for observation of algae and bubble
interactions was a Kodak SR-500 Motion Corder Analyzer. The camera system has been
used for other studies in this laboratory [Emerson, 2006]. The camera can record at 100,
250, 500, and 1000 frames per second for very high temporal resolution. The camera is
capable of generating images with a maximum spatial resolution of 512 x 480 pixels. At
a frame rate of 250 FPS, the camera records 1365 images for a run time of about 5.5
seconds. Video recorded at 500 FPS has a run time of about 2.75 seconds. The camera
generates 1365 time-stamped bitmap images. The camera outputs directly to a PC for
image processing without losing resolution. The camera also outputs to a video monitor
to observe what the camera is imaging. A Micro-Nikkor 60 mm AF close-up lens was
used for all images captured. The large aperture of this lens allows the use of standard
lighting. The field of view ranges from 9.7 cm2 to 25 cm2.
The bitmap images produced by the camera are in an uncompressed format.
These files are very large, and video generated from them can be very large, as much as
700-800 MB.

In order to reduce file size, all bitmap images were converted to

compressed JPEG files with Corel Photopaint 11. The JPEGS were then assembled into
an AVI format movie using VideoMach software. Refer to Appendix B for a more
complete movie building protocol.
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CHAPTER 4
RESULTS
A systematic study was performed to determine the flotation efficiency of
chlorella algae flotation. In order to determine effective flocculation chemistries for use
in flotation, flocculation beaker tests were performed and flocs formed were imaged with
light microscopy.

The average equivalent diameter of the flocs formed for each

chemistry was calculated with blob analysis.
Seven chemistries were chosen based on the flocculation beaker tests for study in
the 3 available bubble facilities. Algal cell and bubble interactions were imaged in the
stationary bubble facility, which suspends a bubble on the tip of a needle in a quiescent
fluid. Algal cell and bubble interactions were imaged in the suspended bubble facility,
which suspends bubbles in a down flow of water. The flotation process was imaged in
the EFC during flotation runs for the seven selected chemistries.
Algae pads were constructed from the algae foam collected in the EFC and
Denver D-12 Flotation Cell for each chemistry tested. The mass of algae was calculated
and used to determine the flotation efficiency for each run.
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4.1 Flocculation Beaker Tests and Microscope Slide Results
The results of the flocculation beaker tests provided valuable qualitative data,
while the corresponding microscope slides prepared from these tests provided useful
quantitative data. All flocculation beaker tests were performed at 22 °C and pH 7. The
33 chemistries listed in Table 3-1 were tested. Based on the results of these 33 tests,
seven chemistries that yielded the largest average floc size were chosen for additional
testing in the bubble facilities. Figure 4-1 shows digital images of the flocculation beaker
tests one minute into the test and Figure 4-2 after fifteen minutes of settling for the seven
chemistries listed in Table 3-2. Table 4-1 accompanies these figures and provides the
details of the chemical concentrations in each run.
Blob analysis was performed on each of the microscope slides prepared during the
flocculation beaker tests to determine the average equivalent diameter of the flocs
generated in each run.

Figures 4-3 and 4-4 show the blob analysis results for the

chemistries containing alum, gelatin, and cellulose. Figures 4-5 and 4-6 show the blob
analysis results for the chemistries containing iron nitrate, chitosan, and cellulose. Tables
4-2 through 4-5 accompany these figures and provide the details of the chemical
concentrations in each run.

For those runs containing cellulose, blob analysis was

employed to determine the floc to fiber ratio, defined as the average floc area divided by
the average fiber area. Figure 4-7 presents the floc to fiber results for chemistries
containing cellulose. Table 4-6 provides the details of the chemical concentrations in
each run. Refer to Appendix D for statistical data.
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Figure 4-1: Flocculation beaker images while stirring.

Table 4-1: Chemistries for Figure 4-1 and Figure 4-2.
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Figure 4-2: Flocculation beaker images after 15 minutes of settling.

68

Figure 4-3: Microscope slide results. Average equivalent floc diameter for
chemistries containing alum and gelatin.

Table 4-2: Chemistries for Figure 4-3.
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Figure 4-4: Microscope slide results. Average equivalent floc diameter for
chemistries containing alum, gelatin, and cellulose.

Table 4-3: Chemistries for Figure 4-4.
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Figure 4-5: Microscope slide results. Average equivalent floc diameter for
chemistries containing iron nitrate and chitosan.

Table 4-4: Chemistries for Figure 4-5.
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Figure 4-6: Microscope slide results. Average equivalent floc diameter for
chemistries containing iron nitrate, chitosan, and cellulose.

Table 4-5: Chemistries for Figure 4-6.
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Figure 4-7: Floc to fiber ratio for cellulose chemistries.

Table 4-6: Chemistries for Figure 4-7.
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4.2 Stationary Bubble Facility Results
Interactions between algal cells and bubbles were imaged in the stationary bubble
facility for the seven chemistries listed in Table 3-2.

Algae containing no added

flocculants was also imaged under varying solution pH and temperature. Adsorption of
algae to bubbles was not seen for any of the chemistries tested. This may be attributed to
the generally large size of bubbles produced in this facility as well as other factors.
Typical bubble diameters produced in the stationary bubble facility range from 0.75-1.25
mm. In all cases, algae approached and followed the curve of the bubble. Once the algae
reached the bottom of the bubble, it did not adsorb and continued past the bubble and
settled on the bottom of the vessel.
Images captured in the stationary bubble facility were converted to avi format
movies.

Refer to Appendix C for a complete list of all movies generated and the

corresponding conditions evaluated. Figure 4-8 is a series of frames captured by the
high-speed camera during a run in the stationary bubble facility. The concentration of
iron nitrate was 100 ppm and the concentration of chitosan was 1.25 ppm. The series of
images tracks an algae floc as it travels down the bubble but does not adsorb. Figure 4-9
presents individual frames from the seven chemistries tested showing no algae adsorption
to bubbles.
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Figure 4-8: Series of frames from the stationary bubble facility. Image
sequence is from left to right starting from the top left.
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Figure 4-9: Individual frames from the stationary bubble facility showing no
algae adsorption.

Table 4-7: Chemistries for Figure 4-9.
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4.3 Suspended Bubble Facility Results
Interactions between algal cells and bubbles were imaged in the suspended bubble
facility for the seven chemistries listed in Table 3-2. Frames were captured by the highspeed camera for each run during normal operation (filled and flowing at steady state) as
well as while the facility was being loaded (filled with test algae). During normal
operation, algae was not seen to adsorb to bubbles for any chemistry tested. However,
algae was clearly seen to adsorb to bubbles during filling of the facility for all chemistries
tested except the control run (algae and water only). The primary difference between the
bubbles present during normal operation and those present during filling of the facility is
size. Typical bubble sizes observed during normal operation were in the range of 1-5
mm, while those observed during loading were in the range of 50-650 µm.
Figure 4-10 is a series of frames captured by the high-speed camera during filling
of the facility for Run B, which corresponds to iron nitrate and chitosan concentrations of
50 ppm and 1.25 ppm respectively and a cellulose to algae mass ratio of 1:1. It is clearly
seen that a large amount of algae has adsorbed to the bubble in the frame and is rising
through the column. Several smaller bubbles are also completely covered in flocculated
algae. This network of algae and bubbles is actually sinking in the column due to the
weight of the algae. Several separate flocs are seen to adsorb to bubbles forming a larger
network of flocculated algae on the bubble. Figure 4-11 presents individual frames from
the same run highlighting the bubbles with adsorbed algae. Algae was observed to
adsorb to bubbles of similar sizes during loading of the facility for all chemistries tested
except the control run, although no images were captured for the control run. Figure 4-12
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shows individual frames for the seven chemistries tested in Table 3-2 during filling of the
facility showing algae adsorption to bubbles.
Figure 4-13 is also a series of frames from Run B, except they were taken under
normal operation of the facility. The bubble diameters in Figure 4-13 are in the range of
5 mm. Bubbles that are around 2 mm or greater show a large departure from a spherical
morphology. The bubbles in Figure 4-13 are seen to distort under the flow field during
operation. Algae flocs are clearly seen traveling past the bubble without adsorbing. No
algae was observed to adsorb to bubbles during normal operation of the suspended
bubble facility for the chemistries tested. Figure 4-14 presents individual frames for the
seven chemistries tested in Table 3-2 during normal operation of the facility, showing no
algae adsorption.
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Figure 4-10: Suspended bubble facility. Frames captured during loading of the
facility for Run B. Image sequence is from left to right starting with the top left
image.
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Figure 4-11: Individual frames from Figure 4-10 highlighting bubbles with
adsorbed algae. Bubbles attached to the same mass of algae are highlighted in
yellow.
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Figure 4-12: Individual frames during filling of the suspended bubble facility
showing algae adsorption.

Table 4-8: Chemistries for Figure 4-12
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Figure 4-13: Suspended bubble facility. Frames captured during normal
operation for Run B. Image sequence is from left to right starting with the top left
image.
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Figure 4-14: Individual frames during normal operation of the suspended
bubble facility showing no algae adsorption.

Table 4-9: Chemistries for Figure 4-14
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4.4 Electrochemical Flotation Cell Results
The seven chemistries listed in Table 3-2 were tested in the EFC utilizing both
hydrogen and air as the gas for flotation. The foam generated in each run was collected
and processed into an algae pad in order to determine the flotation efficiency. Robust
foams were developed in each run except the control (algae and water only) when the test
gas was hydrogen. There was a small amount of foam for the control run when the test
gas was hydrogen, however there was only a small volume of foam present that was
easily disturbed. No foam was observed for any of the conditions tested while the test
gas was air. Figures 4-15 is an image of the foam generated for Run A right before
shutdown for both hydrogen and air as the test gas, which corresponds to an iron nitrate
and chitosan concentration of 50 ppm and 1.25 ppm respectively. A robust foam is
clearly seen for the hydrogen run, with small hydrogen bubbles visible reaching the
surface and breaking through the foam. There is no foam seen when the test gas is air.
Very large bubbles can be seen on the surface without any appreciable algae. Figure 4-16
presents images of the foam generated for the seven chemistries tested in the EFC for
both air and hydrogen as the test gas. These images were taken right after shutdown of
the facility.
Figure 4-19 presents the flotation efficiency for the seven chemistries evaluated in
the EFC. The flotation efficiency was defined as the difference between the total mass of
algae present in each run and the mass of algae remaining unfloated, divided by the total
mass of algae present in each run. The flotation efficiency calculated for the runs
utilizing air are very small, in the range of 1%. The surface of the water was skimmed in
the same manner for the runs utilizing hydrogen, however most of the algae that was
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collected was a result of bubbles bursting on the surface of the water and causing small
amounts of water to spill into the collection chamber. Very little algae was collected as a
foam using the skimmer for the air runs. Table 4-11 presents the calculations used to
determine the flotation efficiency. Figures 4-17 and 4-18 are a series of digital images of
the algae pads generated from the EFC. Pads for each of the seven runs tested are
presented together for comparison of hydrogen and air as the test gas. In each case, the
algae pads produced from the collected foam were a much darker green when the test gas
was hydrogen. The algae pads generated from the unfloated algae remaining in the test
solution are a much lighter green when the test gas is hydrogen, indicating a larger mass
of algae was floated for the hydrogen runs.
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Figure 4-15: Algae foam generated in the EFC. Foam generated after 5
minutes for Run A utilizing hydrogen (a) and air (b) as the flotation gas.
Corresponds to iron nitrate and chitosan concentrations of 50 ppm and 1.25
ppm respectively.
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Figure 4-16: Images of foam generated in the EFC right after shutdown for
hydrogen (top photo) and air (bottom photo) as the test gas.

Table 4-10: Chemistries for Figures 4-16 through 4-19.

87

Figure 4-17: Algae pads generated in the EFC. In each set of 4 pictures: Algae
from foam using hydrogen (top left), unfloated algae remaining using hydrogen
(bottom left), algae from foam using air (top right), and unfloated algae remaining
using air (bottom right). Figure continued on the following page.
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Figure 4-18: Algae pads generated in the EFC. In each set of 4 pictures: Algae
from foam using hydrogen (top left), unfloated algae remaining using hydrogen
(bottom left), algae from foam using air (top right), and unfloated algae remaining
using air (bottom right). Figure continued from the previous page.
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Table 4-11: Flotation efficiency calculations for the EFC.
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Figure 4-19: Flotation efficiency in the EFC.
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4.5 Denver D-12 Flotation Cell Results
The seven chemistries listed in Table 3-2 were tested in the Denver D-12
Flotation Cell.

Algae pads were constructed from the foam collected in each run.

Attempts to generate algae pads from the unfloated algae remaining in the tank were
unsuccessful. The volume of liquid remaining in the tank after each run was about 1.4 L.
The remaining volume was too large to filter using the vacuum pump and the Büchner
funnel due to extensive blinding of the algae on the filter paper. Therefore the flotation
efficiency could not be calculated for the Denver Cell runs.
Although floatation efficiency could not be calculated, it is clear from the digital
photographs of the cell in operation that no appreciable foam was produced for any of the
chemistries tested. Bubbles in the range of 2-6 mm can be seen bursting on the surface,
however there is little or no algal foam accumulation at the surface of the water. Most of
the algae in the pads generated from the collected foam was due to large bubbles bursting
on the surface causing small amounts of the test solution to spill into the collection
chamber. Figure 4-20 is a series of images of the Denver Cell in operation at 5 minutes
showing large bubbles bursting on the surface with little or no algae foam produced.
Images of the algae pads generated from the collected foam also indicate
qualitatively that only a small amount of algae is present on the pads. The algae pads are
mostly white with a very light green tinge indicating very little algal mass. Figure 4-21 is
a series of images of the algae pads generated from the collected foam from the Denver
Cell. In comparison, algae pads produced from collected foam in the EFC when the test
gas was hydrogen (shown in Figures 4-17 and 4-18) show a very dark green color
indicating a large mass of algae present.
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Table 4-12: Chemistries for Figure 4-20 and 4-21.

Figure 4-20: Denver D-12 Flotation Cell after operation for 5 minutes.

Table 4-12: Chemistries for Figure 4-20 and Figure 4-21
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Figure 4-21: Algae pads produced from the foam collected in the Denver
Flotation Cell.
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CHAPTER 5
DISCUSSION OF RESULTS
Image processing techniques were utilized to calculate the average equivalent
diameter of algae flocs produced with iron nitrate, alum, chitosan, gelatin, and cellulose
chemistries. Promising flocculation chemistries were evaluated in the stationary bubble
facility, the suspended bubble facility, the EFC, and the Denver D-12 flotation cell.
Algae pads were constructed from the flotation runs and the mass of algae
removed from the water was calculated. The flotation efficiency of each of the selected
chemistries was determined.
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5.1 Discussion of Algal Flocculation Results
The algae formed stable flocs when exposed to various flocculation chemistries.
The size of the flocs varied with chemistry type, concentration, and the presence or
absence of cellulose. Figure 4-6 shows that the largest flocs were observed for Run 26,
corresponding to an iron nitrate concentration of 50 ppm and a cellulose to algae mass
ratio of 10:1. Run 26 yielded an average equivalent diameter of 187 µm. Figure 4-3
shows that the smallest flocs were observed for Run 17, corresponding to alum and
gelatin concentrations of 100 ppm and 6.25 ppm respectively. Run 17 yielded an average
equivalent diameter of 24 µm. In the absence of any chemicals, the algae did not form
flocs.
There are a few generalizations that can be drawn from the flocculation beaker
tests and the corresponding microscope slides for each run. Figures 4-3 through 4-6
show that algae flocculated with iron nitrate and or chitosan produce larger flocs than
algae flocculated with alum and or gelatin. The largest and smallest average diameters
for iron nitrate and chitosan chemistries are 187 µm (Run 26) and 43 µm (Run 12)
respectively. The largest and smallest average diameters for alum and gelatin chemistries
are 57 µm (Run 14) and 24 µm (Run 17) respectively.

Iron nitrate and chitosan

chemistries typically produce flocs with diameters about twice as large as alum and
gelatin chemistries.
Secondly, Runs 13-17 in Figure 4-3 show that increasing the concentration of
gelatin leads to a decrease in the average equivalent floc diameter of about 40% for algae
treated with alum and gelatin. Runs 18-21 in Figure 4-3 show that addition of alum
beyond about 75 ppm neither increases nor decreases the average equivalent floc
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diameter for algae treated with alum and gelatin. These results of alum and gelatin
chemistries evaluated with the flocculation beaker tests provided guidelines for selecting
the alum and gelatin chemistries evaluated with the various bubble facilities.
Thirdly, Runs 1-5 in Figure 4-5 show that increasing the concentration of chitosan
leads to a decrease in the average equivalent floc diameter of about 30% for algae treated
with iron nitrate and chitosan. Runs 6-10 in Figure 4-5 show that there is no clearly
evident trend in average equivalent floc diameter for varying concentrations of iron
nitrate for algae treated with iron nitrate and chitosan. The results of iron nitrate and
chitosan chemistries evaluated with the flocculation beaker tests provided guidelines for
selecting the iron nitrate and chitosan chemistries evaluated with the various bubble
facilities.
Lastly, the addition of cellulose has a positive effect on the average equivalent
floc diameter for iron nitrate and chitosan chemistries and little effect on alum and gelatin
chemistries. Addition of cellulose increases the average equivalent diameter about 30%
for iron nitrate and chitosan chemistries. The largest average equivalent diameter was
observed for an iron nitrate concentration of 50 ppm and a cellulose to algae mass ratio of
10:1. Figure 4-7 shows that the floc to fiber ratio is about 6 for iron nitrate and chitosan
chemistries, indicating the majority of the flocs are algae as opposed to cellulose. A floc
to fiber ratio of 6 corresponds to floc/fiber networks with algae occupying 85% of the
total area with the remainder cellulose. This suggests that chitosan can be replaced with
cellulose. From a processing perspective, replacing chitosan with cellulose would greatly
reduce the cost associated with flocculating the algae to be floated. Also, if the algae
meal remaining after lipid extraction is to be used as an animal feedstock, cellulose
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would have to be added to the meal before it can be used as a feedstock [Putt, 2007].
Therefore addition of cellulose at the flocculation step would not require a removal step
further down the processing line.
Flocs produced with iron nitrate and chitosan chemistries were very stable
compared to those produced with alum and gelatin chemistries. While stirring in the
flocculation beaker tests, all flocs reached a maximum size within a few seconds of
adding the secondary flocculant (chitosan or gelatin). Flocs that collided did not combine
to form larger flocs but rather bounced off of each other and remained the same size.
After 15 minutes of settling, flocs that were stirred a second time returned to a similar
size, indicating that flocs do not combine into larger flocs when settled on the bottom of
the vessel. While pipetting samples from the flocculation beaker tests for the microscope
slides, the iron nitrate and chitosan flocs stayed together while the alum and gelatin flocs
were easily disturbed. During the foam collection step in the EFC, the alum and gelatin
foams were easily disturbed by the glass skimmer and were partially re-dispersed in the
water while the iron nitrate and chitosan foams remained stable during skimming.
Qualitative assessments of the flocculation beaker tests do not always agree with
quantitative data drawn from the corresponding microscope slide photographs. In several
cases very large flocs of mm scale diameter were observed in the beaker while the test
solution was stirring. However, when samples from the same conditions were analyzed
with blob analysis, the average floc diameters were smaller than 0.2 mm in the largest
case. Comparison of flocculation beaker images for Runs 1 and 5 (Figure 5-1) is an
example.

The images show that Run 5 exhibits larger flocs than Run 1 while the

solutions were stirring.

However when samples were drawn from the beakers and
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analyzed under the microscope, Run 1 had an average equivalent diameter of 112 µm and
Run 5 had a diameter of 75 µm.
The discrepancy is attributed to the method in which the microscope slides were
prepared. Each slide shows only a very small representation of the test run and may not
be representative of the actual average size. Also, the flocs sampled may have been
disturbed by the action of the pipette while collecting samples. The pipette openings
were widened to minimize this effect. Lastly, the assumed depth of the flocs on the
microscope slides of 10 microns has a large effect on the calculated average floc diameter
and may be underestimated.
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Figure 5-1: Flocculation beaker test images for Run 5 (a) and Run 1 (b).
Corresponds to iron nitrate and chitosan concentrations of 75 ppm and 0.5 ppm
for Run 5 and 75 ppm and 2.5 ppm for Run 1 respectively.
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5.2 Discussion of Algal Cell Adsorption to Bubbles
The results from the four bubble facilities utilized in this study suggest that algal
cells and algae flocs do not adhere to large bubbles. For the purposes of this discussion a
large bubble is considered to have a diameter of 0.75 mm or greater. No algal cell
adsorption to bubbles was observed for any of the conditions tested in the stationary
bubble facility. Bubbles produced in this facility are typically on the order of 1-2 mm; it
is very difficult to produce a bubble with a diameter smaller than 0.75 mm in this facility.
The pH variation study further supports this assessment.

No algal adsorption was

observed for any pH condition tested in this facility, however other studies have had
success floating algae in a low pH environment without additional chemicals [Levin et
al., 1961]. The injection technique used for the stationary bubble facility sets up an
almost guaranteed collision of particles with the bubble. This may support the idea that
algal cells did not adsorb to the bubbles in this facility because of their large diameters.
The suspended bubble facility provides anecdotal evidence that algal cells can
adhere to smaller bubbles, but not larger ones. Figure 5-2 shows algae flocs adsorbed to
a bubble of 500 µm diameter while a bubble of 3 mm diameter in the same frame does
not have any algae adsorbed to it. Images captured by the high-speed camera during
filling of the suspended bubble facility clearly show algae adsorption to bubbles
introduced during loading. Most of the bubbles produced during filling are 25-700 µm in
diameter. Figure 4-12 clearly shows a large mass of algae attached to several bubbles. In
some cases the volume of algae attached to a bubble was many times greater than the
volume of the bubble. In other cases, several bubbles were attached to the same algal
mass. However, during normal operation of the facility, no algae was observed to adsorb
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to any bubbles. The bubbles produced during normal operation are very large, in the
range of 1-6 mm.
The EFC provides concrete evidence that algal cells can adsorb to small bubbles.
When the test gas was hydrogen, all chemistries tested in this facility, including to some
extent the control run, showed algal floc and algal cell adsorption to bubbles. The size of
the bubbles produced is very small, on the order of 50 µm, and can be controlled by
varying the amount of current supplied to the fuel cell. Evidence suggests that it is the
small bubble size and not the composition of the gas that has a greater effect on algae
adsorption. When the test gas in the EFC was air, there was no algal cell adsorption
observed for any chemistry tested. However this is attributed to the size of the air
bubbles produced by the aeration stones, which were in the range of 1-3 mm. The
anecdotal evidence captured by the suspended bubble facility during filling supports this
claim. The seven chemistries tested in the suspended bubble facility were identical to
those tested in the EFC with both air and hydrogen as the test gas. No algal cell
adsorption was observed in the suspended bubble facility during normal operation or in
the EFC when air was the test gas. However algal cell adhesion was observed in the
suspended bubble facility during filling and in the EFC when the test gas was hydrogen,
suggesting that the size of the bubbles is the main factor in determining the extent of algal
cell adsorption.
Although production of algae pads from the water in the D-12 Denver Flotation
Cell was unsuccessful, these tests further support the claim that algal cells do not adsorb
well to large bubbles. Typical bubble sizes produced by the Denver Cell under the
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conditions tested were on the order of 1-3 mm, and no algal cell adsorption was observed
for any of the seven chemistries evaluated in the Denver Cell.
The flotation tests conducted in the EFC also provide an assessment of the
flocculation strength of the iron nitrate/chitosan and alum/gelatin chemistries tested.
Figure 4-19 clearly shows that in all cases, iron nitrate and chitosan chemistries lead to
higher flotation efficiencies than alum and gelatin chemistries. However, these higher
flotation efficiencies may be related to the stability of the foam produced by each
chemistry. Qualitative assessments of the water clarity and amount of foam produced for
both chemistries suggested that either chemistry is effective for algae flotation. However,
it was more difficult to collect foam generated with alum and gelatin chemistries than to
collect foam generated with iron nitrate and chitosan chemistries. During collection, the
foams generated with iron nitrate and chitosan chemistries remained intact even when
disturbed by the glass skimmer. On the other hand, foams generated with alum and
gelatin chemistries were easily disturbed by the glass skimmer. A significant amount of
algae left the foam and was resuspended in the test solution by the action of the skimmer
for the alum and gelatin chemistries.

A foam stabilizer may improve the flotation

efficiency of alum and gelatin chemistries. The stability of the foam layer and the
incorporation of algae into it appears to be related to the primary flocculant (iron nitrate
or alum), while the secondary flocculant (chitosan or gelatin) has little or no effect. In all
cases that iron nitrate was the primary flocculant, the foam was very stable regardless if
chitosan was present or not. In all cases that alum was the primary flocculant, the foam
was relatively unstable regardless if gelatin was present or not.
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Flotation efficiency increases with increasing average equivalent floc diameter.
Figure 5-3 shows that flotation efficiency increased by 50% when the average floc
diameter increased from 40 µm to 130 µm. Figure 5-3 reveals that iron nitrate and
chitosan chemistries are superior to alum and gelatin chemistries for both flocculation
and flotation effectiveness. The figure also shows that algae without flocculants does not
float to any significant extent and flocculants are necessary in the flotation of algae even
for small diameter bubbles.
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Figure 5-2: Frame from the suspended bubble facility during filling for
Run A. The larger circled bubble is 3 mm in diameter and shows no algal
adsorption. The smaller circled bubble is 0.5 mm in diameter and algal
adsorption is highlighted with an arrow.
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Figure 5-3: Flotation efficiency evaluated in the EFC versus average
equivalent floc diameter calculated from microscope samples of flocculation
beaker tests.

Table 5-1: Chemistries for Figure 5-3.
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5.3 Discussion of Bubble Imaging Results
Although no algal cell adsorption to bubbles was observed in the stationary
bubble facility, imaging of algal cell and bubble interactions in this facility were useful to
demonstrate how single cells and algae flocs approach and interact with bubbles. Single
cells and small diameter flocs were shown to approach the bubble surface and follow
streamlines around the bubbles and continue to the bottom of the vessel. Larger flocs
have a larger inertial force and interact with bubbles differently. Larger flocs were seen
to approach the bubble and strike the bubble surface. These flocs then bounced off of the
bubble surface and continued to the bottom of the vessel. Contact with the bubble is
crucial to adsorption, and therefore larger flocs have a greater likelihood to adsorb to
bubbles.
The studies in the suspended bubble facility were successful in imaging algal cell
adsorption to bubble surface during filling of the facility. No adsorption was observed
during normal operation of the facility. Incorporation of smaller bubbles, on the order of
25-800 microns, into the facility under normal operation is recommended. Evidence
discussed in section 5.2 suggests algae would successfully adsorb to bubbles in this size
range.
Imaging of algal cell adsorption to bubble surfaces in the EFC was successful.
Images captured at the water air interface show that some bubbles with adsorbed algae
approaching the surface are forced back down into the test solution. This suggests that
flow patterns in the cell are important and the structural design of the flotation vessel
should be considered in detail.
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5.4 Recommendations
Imaging of algal cell and bubble interactions provides a useful method for
studying algal flotation. Videos offer a quick procedure to determine the viability of
different flocculation chemistries to float algae. Visualization of the entire procedure and
not just the end results offers insights into how to improve the flotation process. Future
work may employ blob analysis on individual frames to determine the volume of algae
attached to a bubble.
The results of this work indicate that iron nitrate and chitosan are effective
flocculants that improve algae flotation. Future work to determine concentrations of
these chemicals that further enhance flotation is recommended. Other flocculants are
available that may be effective for algal flotation that should be evaluated, such as
polyacrylamides.
Results from the bubble facilities indicate that small bubbles in the range of 20750 µm are more effective for algal flotation. The ability to produce bubbles of these
sizes in the stationary and suspended bubble facilities are needed to validate this
assertion. A smaller needle capable of producing bubbles in this size range should be
used in the stationary bubble facility. Smaller bubbles may be produced in the suspended
bubble facility with a smaller needle or through electrochemical methods. Preliminary
findings suggest that hydrogen and air are both effective for algal flotation, however the
ability to produce bubbles of the same size in all of the bubble facilities are needed for
concrete evidence. Based on this assertion, DAF is more promising than induced air
flotation for the flotation of algae because DAF generates bubbles in the 20-750 µm
range.
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CHAPTER 6
CONCLUSIONS
Flocculation beaker tests were used to determine the average equivalent diameter
of algae flocs.

Iron nitrate and chitosan chemistries as well as alum and gelatin

chemistries were evaluated. Iron nitrate and chitosan chemistries were found to produce
larger and more stable algae flocs than alum and gelatin chemistries. The addition of
cellulose can replace the need for chitosan when iron nitrate is the primary flocculant.
Samples of the flocculation beaker tests were mounted on microscope slides and imaged.
Image processing techniques were used to determine the average equivalent diameter of
the flocs. The largest average equivalent diameter of 187 µm was observed for an iron
nitrate concentration of 50 ppm and a cellulose to algae mass ratio of 10:1. The smallest
average equivalent diameter of 24 µm was observed for alum and gelatin concentrations
of 100 ppm and 6.25 ppm respectively. Increasing the concentration of the secondary
flocculant (chitosan or gelatin) beyond a few ppm decreased the average equivalent
diameter. Iron nitrate, alum, chitosan, and gelatin concentrations of 50 ppm, 100 ppm,
1.25 ppm, and 3.75 ppm respectively were selected for testing in the bubble facilities.
Observations in the stationary bubble facility were unsuccessful in imaging algal
cell adsorption to bubbles. They were useful to visualize how individual cells and larger
flocs interact differently with bubble surfaces in a quiescent fluid.
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Adsorption of algal cells to bubble surfaces was successfully imaged in the
suspended bubble facility while the apparatus was being filled, however no adsorption
was observed during normal operation of the facility.

Future studies may include

alteration of the suspended bubble facility to allow production of bubbles in the 0.1-0.7
mm diameter range. Algal flocs were seen to adsorb more easily to bubbles in this size
range.
Algae pads were constructed from collected algae separated in the EFC. The
facility was operated using both hydrogen and air as the flotation gas. The mass of algae
on the pads was used to quantify flotation efficiency. Algal foams generated with iron
nitrate and chitosan chemistries are more stable than those generated with alum and
gelatin chemistries. Iron nitrate and chitosan concentrations of 50 ppm and 1.25 ppm
respectively produced the highest flotation efficiency of 83%. The lowest flotation
efficiency of 29% was observed for alum and gelatin concentrations of 100 ppm and 3.75
ppm respectively.

Flotation efficiency increases with increasing average equivalent

diameter.
Determination of flotation efficiency in the Denver D-12 flotation cell was not
possible due to blinding of the filter paper while filtering the clarified water. Algae pads
were constructed from the collected foam. The Denver Cell provided evidence that
supports the claim that algae adsorb to smaller bubbles more easily than larger bubbles.
Future studies may include the incorporation of an electrochemical cell within the
suspended bubble facility in order to produce smaller bubbles for flotation. A smaller
needle fabricated from glass capillary tubing may be used in the stationary bubble facility
to image algal cell and bubble interactions in a quiescent fluid for bubble sizes in the
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range of a few hundred µm. Imaging techniques may be used to calculate the mass of
algae attached to an imaged bubble with blob analysis. Through these techniques a
clearer picture of the algal flotation process may be achieved.

111

BIBLIOGRAPHY
Alonso, D.L., Belarbi, E.H., Fernández-Sevilla, J.M., Rodríguez-Ruiz, J. and Grima,
E.M. [2000] Acyl Lipid Composition Variation Related to Culture Age and
Nitrogen Concentration in Continuous Culture of the Microalga Phaeodactylum
Tricornutum, Phytochemisty, 54, 461-471.
Biermann, C.J. [1996] Handbook of Pulping and Papermaking. Academic Press.
Bilanovic, D. and Shelef, G. [1988] Flocculation of Microalgae with Cationic Polymers –
Effects of Medium Salinity, Biomass, 17, 65-76.
Cassell, E.A., Kaufman, K.M. and Matijević. [1975] The Effects of Bubble Size on
Microflotation, Water Research, 9, 1017-1024.
Chen, Y.M., Liu, J.C. and Ju, Y.H. [1998] Flotation Removal of Algae from Water,
Colloids and Surfaces B, 12, 49-55.
Clift, R., Grace, J.R. and Weber, M.E. [2005] Bubbles, Drops, and Particles, Dover
Publications, Mieola, NY.
Davies, A. [2000] Visualization of Flexographic and Offset Ink at Bubble Surfaces,
Masters Thesis, Auburn University.
Davies, A. and Duke, S.R. [2000] Visualization of Flexographic and Offset Ink at Bubble
Surfaces, TAPPI Recycling Symposium, Vol. II, Hyatt Crystal City, Washington
DC, March 5-8, 2000.
Davies, A. and Duke, S.R. [2000] Visualization of Ink Removal Processes, Paper Age,
July 2000.
Davies, A., Rossi, L. and Duke, S.R. [2000] A Method for Visualization and
Measurement of Ink Adsorption Rates at Bubble Surfaces, Fundamentals and
Numerical Modeling of Unit Operations in the Forest Products Industries,
AICHE Forest Products Symposium, Series No. 324, Volume 96, 2000. 28-36.
Emerson, Z.I. [2003] Visualization of Toner Ink and Adhesive Particles at Bubble
Surfaces, Masters Thesis, Auburn University.

112

Emerson, Z.I., Bonometti, T., Krishnagopalan, G.A. and Duke, S.R. [2006] Visualization
of Toner Ink Adsorption at Bubble Surfaces, TAPPI Journal, 5(4).
Ham, J. [2004] Enzyme Enhanced Deinking of Toner Inks, Masters Thesis, Auburn
University.
Han, X., Miao, X. and Wu, Q. [2006] High Quality Biodiesel Production from a
Microalga Chlorella Protothecoides by Heterotrophic Growth in Fermenters,
Journal of Biotechnology, 126(4), 499-507.
Hung, M.T. and Liu, J.C. [2006] Microfiltration for Separation of Green Algae from
Water, Colloids and Surfaces B, 51, 157-164.
Jameson, G.J. [1999] Hydrophobicity and Floc Density in Induced-Air Flotation for
Water Treatment, Colloids and Surfaces A, 151, 269-281.
Kivakaran, R. and Pillai, V.N.S. [2002] Flocculation of Algae Using Chitosan, Journal of
Applied Phycology, 14, 419-422.
Kragh, A.M. and Langston, W.B. [1961] The Flocculation of Quartz and Other
Suspensions with Gelatine, Journal of Colloid Science, 17(2), 101-123.
Levin, G.V., Clendenning, J.R., Gibor, A. and Bogar, F.D. [1961] Harvesting of Algae by
Froth Flotation, Resources Research Inc.
Liu, X., Xu, J. and We, Q. [2007] Large Scale Biodiesel Production from microalga
Chlorella Protothecoids Through Heterotrophic Cultivation in Bioreactors,
Biofuels and Environmental Biotechnology, Accepted Preprint.
Liu, J.C., Chen, Y.M. and Ju, Y.H. [1999] Separation of Algal Cells from Water by
Column Flotation, Separation Science and Technology, 34(11), 2259-2272.
Martin, T. and Britz, H. [2002] The New EcoCell Flotation for Primary and Secondary
Stages. Voith Sulzer Paper Technology.
Mayo, A.W. and Noike, T. [1994] Response of Mixed Cultures of Chlorella Vulgaris and
Heterotrophic Bacteria to Variation of pH, Water Science and Technology, 30,
285-294.
Morita, M., Watanabe, Y., Okawa, T. and Saiki, H. [2001] Photosynthetic
Productivity of Conical Helical Tubular Photobioreactors Incorporating Chlorella
sp. Under Various Culture Medium Flow Conditions, Biotechnology and
Bioengineering, 74, 136-144.

113

Oh, H.M., Lee, S.J., Park, M.H., Kim, H.S., Kim, H.C., Yoon, J.H., Kwon, G.S. and
Yoon, B.D. [2001] Harvesting of Chlorella Vulgaris Using a Bioflocculant from
Paenibacillus sp. AM49, Biotechnology Letters, 23, 1229-1234.
Planas, M.R. [2002] Development of Techniques Based on Natural Polymers for the
Recovery of Precious Metals, Dissertation, Universitat Politècnica de Catalunya.
Putt, R. [2007] Algae as a Biodiesel Feedstock: A Feasibility Assessment, Draft
Submitted to Center for Microfibrous Materials Manufacturing.
Putt, R. [2007] Personal communications, Auburn University.
Rodrigues, R.T. and Rubio, J. [2007] DAF-Dissolved Air Flotation: Potential
Applications in the Mining and Mineral Processing Industry, International
Journal of Mineral Processing, 82, 1-13.
Rossi, L. [1998] Auburn University Internship Report, University of Toulouse, France.
Sheehan, J., Dunahay, T., Benemann, J. and Roessler, P. [1998] A Look Back at the U.S.
Department of Energy’s Aquatic Species Program – Biodiesel from Algae,
NREL/TP-580-24190.
Stead, A.D., Cotton, R.A., Duckett, J.G., Goode, J.A., Page, A.M. and Ford, T.W. [1995]
The Use of Soft X Rays to Study the Ultrastructure of Living Biological Material,
Journal of X-Ray Science and Technology, 5, 52-64.
Svedala Corporation [1996] Denver D-12 Laboratory Flotation Cell User’s Manual.
Yao-de, Y. and Jameson, G.J. [2003] Application of the Jameson Cell Technology for
Algae and Phosphorus Removal from Maturation Ponds, International Journal of
Mineral Processing, 73, 23-28.

114

APPENDIX A
BLOB ANALYSIS PROCEDURE
The following steps outline the procedure to calculate a specified area in an
image, which was used to determine the average equivalent floc diameter.
Scale Calibration
1. Open ImageJ
2. Click File > Open and locate the appropriate image of the ruler on a microscope
slide to set the scale
3. Click on the “Straight line selections” button on the toolbar
4. Draw a straight of known distance on the image between two ruler tick marks
5. Click Analyze > Set Scale
6. The distance in pixels of the line is displayed in the “Distance in Pixels” box
7. Type the distance of the line in the “Known Distance” box
8. Set the unit of the distance of the known line in the “Unit of Length” box
9. Check the “Global” checkbox and click the ok button
Floc Area Measurement
1. Close the image of the ruler on the microscope slide
2. Click File > Open and locate the first microscope slide image to be analyzed
3. Click the “Polygon selections” button on the toolbar
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4. For each floc to be measured, click on the outside edge of the floc and trace the
area of the floc
5. When the entire floc area is highlighted, double click the mouse to close the
polygon
6. Click Analyze > Measure (alternatively press ctrl-m)
7. The area of the floc in the specified units is displayed in another window
8. Repeat the procedure for all flocs to be measured
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APPENDIX B
MOVIE BUILDING PROCEDURE
The following steps outline the procedure to convert frames captured by the
Kodak MotionCorder High-Speed Camera into a digital movie in avi format.
File Batch Change
1. Open Corel PhotoPaint 11
2. Click File > Batch change on the toolbar
3. In the new window, click Add file
4. Navigate to the folder the images are stored in and click on the first file
(f_000001.bmp) in the directory and then scroll down to the 800th file (f_000800)
and click it while holding the SHIFT key.
5. Confirm that “Save as new file” is highlighted
6. Set the save to folder as the destination where the converted files are to be saved
7. Set the “save as” type as JPG
8. Click PLAY
9. Corel will open and close a new window for each image, after all images have
been converted, open Windows Explorer
10. Copy and run the batch file change script (change.bat) to the directory where the
converted images were saved. The change.bat script renames the JPG files for
movie building.
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Movie Building
1. Open VideoMach
2. Click on the “Open video and audio files” folder icon
3. In the new window, locate the directory where the JPG images are saved
4. Select the entire range of images to be compiled into a movie and click open
5. Click File > Save
6. In the new window, set the “Output Mode” dropbox to video only
7. Under the “Write VIDEO and AUDIO to this file” dropbox, specify the
directory where the movie is to be saved
8. Click the video tab at the top of the window
9. Click the resize button
10. In the new window uncheck the “automatic box” and change the “Make
resolution divisible by” to 4 and click the ok button
11. Click the rotate button
12. Click on the “90 degrees right” button and click the ok button
13. Under the “Frame Rate (fps)” section, uncheck the “automatic” box
14. Enter the frame rate in frames per second that the images were captured at
15. In the dropbox, select “Keep original number of frames”
16. Click save
17. When the movie building is complete (1-10 minutes) the movie is created in
the specified directory

118

APPENDIX C
LIST OF VIDEOS
The following is a list of all movies captured by the high-speed camera. File
names that include “RepX” refer to the replicate number. For replicated videos, 3 Reps
were performed for each condition listed except for the EFC hydrogen Runs which have
2 Reps for each condition listed.
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Table C-1: List of Videos

120

APPENDIX D
FLOC SIZE ANALYSIS

Table D-1: Flocculation beaker test calculations
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